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Manutenção e Solução de Problemas 

 

Verificações de Rotina da Manutenção 
 

Considerando que o Relé SEL-701 é equipado com recursos abrangentes de autodiagnose, a forma mais eficaz de 
manutenção consiste em monitorar o contato ALARM do relé. O contato de saída ALARM fecha quando o relé é 
desenergizado ou quando uma falha é detectada pela autodiagnose do relé. Se você estiver monitorando o contato 
ALARM, saberá imediatamente se o relé está desenergizado ou se houve detecção de uma falha. Além disso, 
recomendamos que sejam analisados os relatórios de evento do relé que são gerados após a ocorrência de faltas. 
Essa análise revela, freqüentemente, problemas associados aos equipamentos externos ao relé, tais como 
transformadores de tensão e fiação de controle. 

O Relé SEL-701 não requer testes específicos de rotina, porém as padronizações de operação do usuário podem 
requerer algumas verificações periódicas. Se houver necessidade ou se o usuário quiser efetuar verificações 
periódicas no relé, recomendamos verificar os itens indicados a seguir. 

Verificação do Status do Relé 
Use a função Status of Relay do painel frontal ou o comando STATUS via porta serial para verificar se a 
autodiagnose do relé não detectou qualquer condição fora de tolerância. 

Verificação do Medidor  
Verifique se o relé está medindo os sinais de corrente e, caso incluído, os sinais de tensão, comparando a leitura 
do medidor do relé com a leitura de um medidor separado conectado em série (para circuitos de corrente) ou em 
paralelo (para circuitos de tensão) com a entrada do relé. 

Verificação dos Contatos de Entrada 
Com o relé e o motor fora de serviço, efetue o curto-circuito dos contatos de entrada do relé, individualmente, 
usando um jumper ou conectando uma chave/contato de teste. Usando a função View Relay Word/Row 10 do 
painel frontal, verifique o status dos contatos de entrada no display do painel frontal do relé. Ao curto-circuitar 
cada entrada, sua identificação (IN1, IN2, IN3, etc.) deverá aparecer no display do painel frontal. 

Verificação dos Contatos de Saída 
Use o comando Pulse Out Contact\Trip do painel frontal para fechar o contato de saída TRIP. Repita para os 
outros contatos de saída. Certifique-se que cada contato esteja operando corretamente, de acordo com o esperado, 
verificando as sinalizações, circuito de controle ou circuito de trip associados. Consulte a Section 5: Front-Panel 
Operations e a Section 6: ASCII Serial Port Operation para mais detalhes sobre o comando PULSE. 
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Coleta Periódica de Dados 
Recomendamos efetuar o download das informações do relé usando a programação mostrada na Tabela 10.1. 
 

Tabela 10.1  Coleta de Dados   
Tipo de Informação Programação do Download 

Sumários dos Eventos (HIS) Conforme necessário, para analisar os trips do relé. 

Relatórios de Evento (EVE) Conforme necessário, para analisar os trips do relé. 

Registrador Seqüencial de Eventos (SER) Conforme necessário, para analisar a operação do relé. 

Perfil de Carga (LDP) A cada 30 dias; apague todos os dados da memória 
(“buffers”) quando efetuar o download. 

Estatísticas do Motor (MOT) A cada 3-6 meses ou quando for efetuar a manutenção 
do motor. 

Relatórios das Partidas do Motor (MSR) Após a partida inicial do motor, após qualquer trip com 
rotor travado, e para análise do motor ou do sistema. 

Tendência das Partidas do Motor (MST) A cada 3-6 meses ou quando for efetuar a manutenção 
do motor. 

Medidor Max/Min (MET M) A cada 3-6 meses ou quando for efetuar a manutenção 
do motor. 

Status do Relé (STA) Quando for efetuar a manutenção do motor. 

  

Autodiagnose 
 

O relé executa diversas autodiagnoses. Conforme mostrado abaixo, quando o relé detecta certos tipos de falhas na 
autodiagnose, ele fecha seu contato de saída tipo b ALARM. A monitoração desse contacto é a atividade mais 
importante de manutenção do relé a ser efetuada. 

O relé executa as seguintes ações para as condições consideradas fora de tolerância mostradas na Tabela 10.2. 

Proteção Desabilitada 
O relé: 

• Desabilita todas as funções de proteção e lógicas de partida/parada.  

• Desenergiza todos os contatos de saída. 

• Apaga o LED Relay Enabled do painel frontal. 

Saída ALARM  
O contato de saída ALARM sinaliza uma condição de alarme passando para seu estado desenergizado. 

• O contato de saída tipo b ALARM fecha para uma condição de alarme; o contato de saída tipo a 
ALARM abre para uma condição de alarme ou se o relé for desenergizado.  

• O relé gera o relatório STATUS, via porta serial, quando de falhas. 

• O relé exibe mensagens de falha no seu display. 
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Use o comando STATUS via porta serial ou a função Status of Relay no painel frontal para visualizar o status da 
autodiagnose do relé. 
 

  
Tabela 10.2  Autodiagnoses do Relé   

 Durante a Falha 

Autodiagnose Descrição Limites Proteção 
Desativada

Saída 
ALARM 

Mensagem no 
Painel 

Frontal  

Offset DC  Mede o offset DC em 
cada um dos canais de 
entrada. 

30 mV Não Pulso OFFSET 
WARN 

+5 V PS Mede a fonte de 
alimentação de +5 V. 

+4.65 V 
+5.65 V 

Sim Selada +5V 
FAILURE 

–5 V PS Mede a fonte de 
alimentação de –5 V. 

–4.65 V –
5.40 V 

Sim Selada –5V 
FAILURE 

+15 V PS Mede a fonte de 
alimentação de +15 V.

+14.00 V 
+16.00 V 

Sim Selada +15V 
FAILURE 

+28 V PS Mede a fonte de 
alimentação de +28 V.

+24.00 V Sim Selada +28V 
FAILURE 

TEMP Mede a temperatura 
na referência de 
tensão do A/D. 

–50ºC +100ºC Sim Selada TEMPER
ATURE 
FAILURE 

RAM Executa um teste 
“read/write” na RAM 
do sistema. 

 Sim Selada RAM 
FAILURE 

ROM Executa um teste de 
“checksum” na 
memória dos 
programas do relé. 

Checksum Sim Selada ROM 
FAILURE 

CR_RAM Executa um teste de 
“checksum” na cópia 
ativa dos ajustes do 
relé. 

Checksum Sim Selada CR_RAM 
FAILURE 

EEPROM Executa um teste de 
“checksum” na cópia 
não volátil dos ajustes 
do relé. 

Checksum Sim Selada EEPROM 
FAILURE 

Cristal do 
Micro-
processador  

Monitora o cristal do 
microprocessador. 

 Sim Selada CLOCK 
STOPPED 

Micro-
processador 

O microprocessador 
examina cada 
instrução, acesso à 
memória e interrupção 
dos programas.  

Falha do teste 
na detecção de 
uma instrução 
inválida, acesso 
à memória ou 
interrupção 
espúria. 

Sim Selada VECTOR 
nn 

Bateria do 
Relógio 

Mede a tensão da 
bateria do relógio em 
tempo real. 

Tensão da 
Bateria <2.50 V

Não Pulso — 
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 Durante a Falha 

Autodiagnose Descrição Limites Proteção 
Desativada

Saída 
ALARM 

Mensagem no 
Painel 

Frontal  

Relógio em 
Tempo Real 

Verifica as funções do 
chip de comunicação, 
manutenção do 
horário e da memória 
do relógio em tempo 
real. 

 Não Pulso — 

Tempo de 
Resfriamento 
“Adquirido” 

Verifica a capacidade 
do relé “aprender” o 
tempo de resfriamento 
do motor. 

Unable to write 
data to target 
address 

Não Pulso — 

Capacidade 
Térmica de 
Partida 
“Adquirida” 

Verifica a capacidade 
do relé de “aprender” 
a capacidade térmica 
de partida do motor. 

Unable to write 
data to target 
address 

Não Pulso — 

  

Procedimentos para Solução de Problemas 
 

O LED Enabled do Painel Frontal do Relé Está Apagado  
 

Tabela 10.3  O LED Enabled do Painel Frontal do Relé Está Apagado   
Causa Possível Solução 

Não existe alimentação nas entradas ou 
houve queima de um fusível. 

Verificar se existe alimentação nas 
entradas e a continuidade dos fusíveis 

 

Falha detectada na autodiagnose. Verificar se o contato tipo b ALARM está 
fechado. Use a função Status of Relay do 
painel frontal para visualizar os resultados 
da autodiagnose. 

 O Display do Painel Frontal do Relé não Exibe os Caracteres  
 
 

Tabela 10.4  O Display do Painel Frontal do Relé não Exibe os Caracteres    
Causa Possível Solução 

Expirou o “time out” (tempo esgotado) do 
painel frontal do relé. 

Pressionar o botão de pressão {ESC} para 
ativar o display. 

O relé está desenergizado. Verificar a continuidade do circuito dos 
fusíveis e alimentação das entradas. 
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O Relé não Mede as Correntes ou Tensões com Precisão  
 

Tabela 10.5  O Relé não Mede as Correntes ou Tensões com Precisão    
Causa Possível Solução 

Erro de fiação. Verificar a fiação das entradas. 

Ajuste incorreto de CTR, ITAP, CTRN, 
INTAP ou PTR. 

Verificar as relações, conexões e ajustes 
associados às fontes dos sinais. 

O terminal da tensão de neutro (D09) não 
está aterrado corretamente. 

Verificar a fiação e as conexões. 

  

O Relé não Responde aos Comandos de um Dispositivo Conectado à Porta 
Serial  
 

Tabela 10.6  O Relé não Responde aos Comandos de um Dispositivo Conectado à Porta Serial    
Causa Possível Solução 

O equipamento de comunicação não está 
conectado ao relé. 

Verificar as conexões dos cabos. 

A taxa baud do relé ou do dispositivo de 
comunicação está incorreta, ou algum 
outro parâmetro de comunicação está 
incompatível, incluindo erro de cablagem. 

Verificar a montagem dos terminais e os 
pinos de conexão dos cabos. 

A porta serial do relé recebeu um caractere 
XOFF, interrompendo as comunicações. 

Digitar <Ctrl+Q> para enviar um 
caractere XON para o relé e restabelecer as 
comunicações. 

O protocolo da porta serial do painel 
traseiro está parametrizado de forma 
diferente da esperada. 

Se você selecionar o protocolo Modbus®, a 
porta serial EIA-232 do painel traseiro é 
desativada. Use a porta EIA-485 para 
efetuar comunicações com o relé via 
Modbus, ou use a porta EIA-232 do painel 
frontal para efetuar comunicações com o 
relé via texto ASCII. Consulte a Section 4: 
Settings Calculations para mais 
informações sobre configurações da porta 
serial.  

 O Relé não Responde às Faltas 
 

Tabela 10.7  O Relé não Responde às Faltas   
Causa Possível Solução 

O relé está ajustado incorretamente. Verificar os ajustes do relé. 

Ajustes incorretos da fonte de teste. Verificar os ajustes da fonte de teste. 

Erro na fiação das entradas do TC ou TP. Verificar a fiação das entradas. 

Houve falha da autodiagnose com bloqueio 
do relé. 

Use a função Status of Relay do painel 
frontal para visualizar os resultados da 
autodiagnose. 
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Substituição do Fusível da Alimentação 
 

A fonte de alimentação do relé é equipada com um fusível que pode ser substituído sem necessidade de 
desmontar o relé. O suporte do fusível está localizado no painel traseiro do relé, logo acima dos terminais de 
entrada da fonte de alimentação, D01–D03. Usando uma chave de fenda comum, empurre levemente o suporte do 
fusível e, em seguida, gire no sentido inverso ao dos ponteiros de um relógio. Após substituir o fusível, insira o 
suporte do mesmo na abertura e, com a chave de fenda, gire no sentido horário para fixação do mesmo. 

Especificações para Substituição do Fusível: T 2 A 250 V, alta capacidade de interrupção. Os números de 
referência (“part numbers”) dos fabricantes mostrados a seguir referem-se a fusíveis adequados para substituição: 
 

   
Fabricante P/N Comentário 

Schurter, Inc. 0001.2507 Equipamento Original 

Wickman USA, Inc. 181.1200.0.02  

Bussman 5505 2A  

Littelfuse 215 002  

  
Contate a SEL caso você encontre dificuldades em obter um fusível equivalente para substituição. Use somente 
fusíveis com alta capacidade de interrupção. 

Substituição da Bateria do Relógio em Tempo Real 
 

Uma bateria de lítio alimenta o relógio do relé (data e hora) se houver perda ou remoção da fonte de alimentação 
externa. A bateria é do tipo “3 V lithium coin cell”, da Rayovac, nº BR2335 ou equivalente. Para salas com 
temperatura de 25°C, a bateria vai operar nominalmente por 10 anos com carga nominal. Se o relé for alimentado 
por uma fonte externa, a bateria somente é submetida a uma pequena taxa de auto-descarga. Dessa forma, a vida 
útil da bateria pode se estender além do valor especificado de 10 anos, pois ela vai, raramente, descarregar após o 
relé ter sido instalado. A bateria não pode ser recarregada. 

Se o relé não estiver mantendo a data e hora após a perda de energia, ou se a autodiagnose do relé indicar RTC 
Battery Warning, substitua a bateria seguindo as etapas relacionadas abaixo. 

Etapa 1. Desenergize o relé. 

Etapa 2. Remova os dois parafusos de fixação do painel frontal usando uma chave de fenda Phillips. 
Cuidadosamente, remova o painel frontal do relé do chassis do relé. 

 
CUIDADO: O relé contém dispositivos sensíveis à Descarga Eletrostática (ESD). Quando estiver trabalhando no relé com o painel 
frontal removido, as superfícies de trabalho e as equipes de trabalho deverão estar aterradas adequadamente ou pode ocorrer danos 
aos equipamentos.  

Etapa 3. A placa principal e o display do relé são fixados na parte interna do painel frontal do relé. A 
bateria está localizada na parte superior do lado esquerdo da placa principal do relé. 
Cuidadosamente, remova a bateria. Descarte adequadamente a bateria velha; ela não é 
recarregável.  

Etapa 4. Instale a nova bateria com o lado positivo (+) da mesma virado para cima. 

Etapa 5. Cuidadosamente, recoloque o painel frontal do relé no chassi do relé. Instale e aperte os parafusos 
de fixação do painel frontal usando a chave de fenda Phillips. 
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ALERTA: Certifique-se de alinhar cuidadosamente o painel frontal com o chassi do relé durante a re-montagem. Se o painel frontal 
não for bem alinhado com o chassi, você pode torcer os pinos dos conectores, provocando a falha do relé. 

Etapa 6. Reenergize o relé. Ajuste a data e hora do relé usando as funções Set Relay\Date e Set 
Relay\Time do painel frontal. 

Instalação da Versão para Upgrade do Firmware  
 

Ocasionalmente, a SEL oferece versões para upgrade do firmware, com o objetivo de melhorar a performance do 
relé. Uma vez que o Relé SEL-701 armazena o firmware em memória flash, não é necessária a troca de 
componentes físicos. Faça o upgrade do firmware do relé transferindo o arquivo para o relé, via porta serial do 
painel frontal, a partir de um computador pessoal, conforme indicado nas seções seguintes. 

Equipamentos Necessários 
• Computador pessoal 

• Software para emulação em terminal compatível com o protocolo XMODEM/CRC(ex., Procomm® 
Plus, Relay Gold, Microsoft Windows® Terminal, SmartCOM e CROSSTALK®) 

• Cabo de comunicação serial (SEL-C234A ou equivalente, ou um cabo null-modem) 

• Disco com o arquivo para upgrade do firmware  

Instruções para Upgrade  
As instruções abaixo assumem que você está familiarizado com o software para emulação em terminal de seu PC. 
Especificamente, você deve saber como modificar os parâmetros de comunicação serial (taxa baud, bits de dados, 
paridade, etc.), selecionar o protocolo de transferência (XMODEM/CRC) e transferir arquivos (ex., transmitir e 
receber arquivos binários). 

Etapa 1. Se o relé estiver em serviço, abra os circuitos de controle do motor. 

Etapa 2. Conecte o PC à porta serial do painel frontal e entre no Nível de Acesso 2. 
 

NOTA:  Sempre verifique os últimos ajustes do relé, incluindo as faixas, de forma que você possa atualizar os mesmos de acordo com 
o upgrade do firmware. Para detalhes sobre a disponibilização dos firmwares e faixas de ajustes associadas, consulte Appendix A: 
Firmware and Manual Versions e Notas sobre Lançamento de Revisão do Produto. 

Etapa 3. Salve os ajustes do relé antes de efetuar o upgrade do firmware. 

Salve os ajustes com: “SEL-5010 Relay Assistant Software”, ou “SEL-5807 PC Software” para o 
SEL-701 (para R112 e anterior), ou o “ACSELERATOR® QuickSet™ SEL-5030 Software” (para 
R112 e posterior). 

Etapa 4. Usando o comando STATUS no prompt do ASCII, verifique a versão de firmware.  

Se o seu Relé SEL-701 possuir a versão de firmware R105, ou anterior, os ajustes atuais do relé 
vão ser apagados durante o procedimento de upgrade.  

Se após o upgrade, o relé mantiver com sucesso os ajustes originais, por favor, faça a análise e a 
revisão dos ajustes conforme for necessário em função das alterações de ajuste no firmware do 
relé. O relé não indica automaticamente, após ou durante um upgrade, os ajustes que estiverem 
fora da faixa; logo, é essencial verificar os ajustes e as novas faixas. 

Além disso, se o seu firmware atual for R103 ou anterior, por favor registre os ajustes de 
calibração efetuando o comando SHO C no prompt do ASCII. 
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Etapa 5. Efetue o comando L_D <Enter> para o relé (L “underscore” D <Enter>). 

Etapa 6. Digite Y <Enter> para o prompt Disable relay to send or receive firmware (Y/N)? e Y 
<Enter> para o prompt Are you sure (Y/N)?. O relé vai enviar o “SELBOOT prompt !>”. 

Etapa 7. Digite BAU 38400 <Enter>. Isso vai alterar a taxa baud da porta de comunicação para 38400. 
Troque a taxa baud do seu PC para 38400 para compatibilizar com o relé. 

Etapa 8. Faça uma cópia do firmware atual do relé. Isso é recomendado para o caso de o download do novo 
firmware ser sem sucesso. Para efetuar o backup do firmware, é necessário um disco com espaço 
livre de aproximadamente 2,3 MB. O procedimento leva menos de 10 minutos para a taxa de 
38400 bauds. 

Efetue o comando SEN <Enter> para iniciar a transferência do firmware. Selecione a 
transferência via protocolo binário XMODEM e o nome do arquivo no seu software de 
comunicação. Dê um nome exclusivo ao arquivo para identificar claramente a versão de firmware 
(ex., 701R100.S19). Após a transferência, o relé vai responder “Download completed 
successfully!”. 

Etapa 9. Inicie a transferência do novo firmware para o relé efetuando o comando REC <Enter> para 
“instruir” o relé para receber o novo firmware. 

Etapa 10. Digite Y para apagar o firmware existente ou apenas <Enter> para abortar. 

Etapa 11.  O relé solicita, então, que você pressione uma tecla e inicie a transferência. Pressione a tecla (ex., 
<Enter>). 

Etapa 12. Inicie a transferência do arquivo selecionando a opção de envio de arquivo no seu software de 
comunicação. Use o protocolo XMODEM e envie o arquivo que contém o novo firmware (ex., 
701R101.S19).  

A transferência do arquivo leva menos de 10 minutos para a taxa de 38400 bauds. Após a 
transferência ter sido completada, o relé vai fazer o reboot e retornar ao Nível de Acesso 1. A tela 
seguinte mostra o processo completo. Se você precisar de comandos adicionais durante o 
processo de upload/download, digite HELP para visualizar os comandos disponíveis. 

 
=>>L_D <Enter> 

Disable relay to send or receive firmware (Y/N) ? Y <Enter> 

Are you sure (Y/N) ? Y <Enter> 

Relay Disabled 

!>BAU 38400 <Enter> 

!>SEN <Enter> 

Download completed successfully! 

!>REC <Enter> 

Caution! - This command erases the relay’s firmware. 

If you erase the firmware, new firmware must be loaded into the relay 

before it can be put back into service. 
Are you sure you wish to erase the existing firmware? (Y/N) Y <Enter> 

Erasing 

Erase successful 

Press any key to begin transfer, then start transfer at the PC <Enter> 
Upload completed successfully. Attempting a restart 

 
Etapa 13.  O relé acende o LED Relay Enabled do painel frontal se os seus ajustes foram mantidos durante o 

download. Se o LED Relay Enabled acender, continue na Etapa 14. Se o LED Relay Enabled não 
acender ou se o display do painel frontal exibir, STATUS FAIL EEPROM FAILURE, carregue 
novamente os ajustes do relé usando o procedimento indicado a seguir. 

a. Defina os ajustes do seu software de comunicação para 2400 bauds, 8 bits de dados, 1 bit 
de parada. 
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b. Entre no Nível de Acesso 2 efetuando o comando 2AC. 
c. Efetue o comando R_S para restaurar os ajustes default de fábrica do relé. O relé vai então 

efetuar o reboot com os ajustes default de fábrica. 
d. Se a mensagem, Calibration settings lost, please call the factory! aparecer 

durante a reinicialização, por favor, contate a fábrica (ver Assistência da Fábrica). 
e. Entre no Nível de Acesso 2. 
f. Efetue o comando STA e verifique se o status do relé está OK. 
g. Ajuste o relógio e o calendário do relé usando os comandos DATE e TIME. 

 
NOTA: Para carregar os ajustes salvos de versões de firmware anteriores a R112 (anterior a SVN 003) no ACSELERATOR QuickSet a 
partir do banco de dados antigo do 701PC, siga estas etapas. 

1 File > Active Database para partir o ACSELERATOR QuickSet. Torne o banco de dados antigo do 701PC como o banco de dados 
ativo.  

2 File > Database Manager e escolha os ajustes a serem importados para o novo driver. Clique Export e salve os cinco arquivos de 
ajuste num local especificado pelo usuário. 

3 Abra o driver do novo 701 selecionando o part number e o SVN desejados. Tools > Import para importar os arquivos. Aceite os 
ajustes e solucione quaisquer erros existentes. 

h. Efetue os ajustes Relay, Ports e SER usando o software ACSELERATOR QuickSet, 
SEL-5010 ou os seguintes comandos: SET, SET P F, SET P R, SET R. 

i. Defina os passwords do relé via comando PAS. 

Etapa 14. Defina os ajustes do seu software de comunicação (taxa baud, numero de bits de dados, numero 
de bits de parada) de forma a compatibilizar com os ajustes das portas do Relé SEL-701. 

Etapa 15. Execute o comando STATUS para verificar se todos os resultados da autodiagnose do relé estão 
OK. 

Etapa 16. Aplique sinais de corrente e tensão ao relé. Efetue o comando METER; verifique se os sinais de 
corrente e tensão estão corretos. Efetue os comandos TRIGGER e EVENT. Verifique se os 
sinais de corrente e tensão estão corretos no relatório EVENT. 

Etapa 17.  Se houver um processador de comunicação da SEL (SEL-2032, SEL-2030 ou SEL-2020) 
conectado ao Relé SEL-701, re-auto-configure a porta do processador de comunicação. Esta 
etapa vai evitar uma falha futura de auto-configuração do processador de comunicação quando 
sua alimentação for chaveada e o novo firmware do Relé SEL-701 não for compatível com a 
configuração original. 

O relé está, agora, pronto para que sejam efetuados os procedimentos de comissionamento. 

Assistência da Fábrica 
 

Agradecemos o seu interesse nos produtos e serviços da SEL. Se houver qualquer dúvida ou comentário, por 
favor entre em contato com: 

SEL - Schweitzer Engineering Laboratories, Brasil Ltda 
Rua Ana Maria de Souza, 61 – Jardim Santa Genebra 
Campinas – SP – CEP: 13084-660 
Tel: (19) 2103-8111 • Fax: (19) 2103-8112 
Internet: www.selinc.com.br • e-mail: geral@selinc.com 

 

SUPORTE TÉCNICO SEL HOT LINE 
Tel: (19) 2103-8110   e-mail: suporte@selinc.com 


